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Housekeeping
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● In the event of a fire alarm, follow our instructions.
○ Proceed to fire exit and wait in the assembly area.

● Please don’t wander off, let us know if you need to 
step out of the lab area.



Workshop 
Objectives
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Explore 
robotics

Learn 
Programming Learn about 

Electronics

Learn about 
A.I.

Insights to 
Research Insights to 

Industry



Schedule
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10:30 - Arrive & register
11:00 - Introductions
11:30 - Arduino 1: Intro
13:00 - Lunch
14:00 - Tour
14:30 - Arduino 2: Sense + Act
15:30 - Processing 1: Visualise
16:30 - End of Day

Day 1
10:30 - Arrive
11:00 - Industry Talk + Q&A
11:30 - Arduino 3: Motion
13:00 - Lunch
14:00 - Arduino 4: AI
15:00 - Challenge Competition
16:30 - End of Day

Day 2
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Aran Sena
PhD Student, CoRE

Undergrad, Mech. & Manuf. Engineering 
- 2008-2012 Trinity College Dublin

Industry, National Instruments
- 2012-2014

Masters Mech. & Manuf. Engineering
- 2014-2016 Trinity College Dublin

PhD, Robotics
- 2016-Current Robot Learning Lab KCL

Research Area 
Learning from Demonstration for Robots in 
Horticulture.



Introductions!
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Tell us your…

- Name
- School
- Year
- A fun fact about you!



Horticultural Robotics Research
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15,000
Full-time equivalent jobs provided by the 

U.K. Horticulture Industry in 2014

http://horticulture.ahdb.org.uk/sites/default/files/u3089/Horticultural%20summary%20report%20web%20version.pdf
https://www.theguardian.com/society/2015/jul/01/sue-biggs-rhs-horticultural-timebomb
https://www.rhs.org.uk/education-learning/careers-horticulture/horticulture-matters/1016-rhs-hort-careers-brochure-v8
http://horticulture.ahdb.org.uk/sites/default/files/u3089/Horticultural%20summary%20report%20web%20version.pdf
https://www.gov.uk/government/uploads/system/uploads/attachment_data/file/525444/UKCESS_2015_Report_for_web__May_.pdf

“We are facing a horticultural timebomb, given an increasingly 
ageing workforce and a skills shortage,” - Sue Biggs, RHS

72%
Percentage of U.K. horticulture businesses 

who could not fill vacancies in 2014

5% ~£1bn
Value of U.K. Ornamentals Industry

(Farm gate value)

Value of U.K. Ornamentals Imports
(~£300m ornamentals, ~£700m cut flowers)

Percentage of U.K. grower’s sales 
generated through export in 2014
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Arduino 1: Intro 

● What is Arduino?
● Uploading & running code.
● Programming basics: C/C++ for Arduino.

○ Program structure
○ Variables
○ Functions
○ Communicating with Arduino
○ Control code
○ Arrays

11



Uploading & 
Running Sketches

1. Connect your Arduino to the PC
2. Open the Arduino IDE
3. File > Examples > 01.Basics > Blink
4. Tools > Board > Arduino/Genuino Uno
5. Tools > Port > Select your Arduino

a. Something like “COM3 (Arduino…)”
6. Click the Compile button (Tick Symbol)
7. Click the Upload button (Arrow Symbol)
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(3) (4) & (5)

(6) (7)

Try this now!



1. void setup(){...}
a. Runs once

2. void loop(){...}
a. Called after setup
b. Runs until Arduino 

powered off/reset.
3. Comments

a. “//” at start of line
b. Or “/* Many lines of 

comments */” for 
multi-line comments

4. End-of line semi-color “;”
5. Curly Braces around functions 

“{...}”
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Basic Sketch 
Anatomy



Code Basics - Variables
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Variable Range / Contents Storage Size Code

int -32,768 -> 32767 16-bit (2-byte) Int var_name = val;

long -2,147,483,647 -> 2,147,483,648 32-bit (4-byte) long var_name = val;

bool true or false 8-bit (1-byte) bool var_name = val;

byte 0 -> 255 8-bit (1-byte) byte var_name = val;

char Used for single characters, e.g. ‘A’ 8-bit (1-byte) char var_name = ‘A’;
char var_name = 65

String Used for multiple characters, and conversion Variable String var_name = String(val);
Int x = 10;
String str_x = String(x);

float -3.4E+38 -> 3.4E+38 (roughly)
6-7 decimal digits of precision

32-bits (4-bytes) float var_name = val;
float x = 1.19;

There are more variable types, and examples of their use here:
Variables reference page - https://www.arduino.cc/reference/en/#variables
ASCII reference chart - https://www.arduino.cc/en/Reference/ASCIIchart

There is 32,256 Bytes available on your 
Arduino (Uno)



Code Basics - Operators
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Operator Action Example

== Equality comparison int a = 1; int b = 1; bool c = a == b; // c is true

!= Inequality comparison int a = 1; int b = 1; bool c = a != b; // c is false

<= Less-than or equal comparison int a = 2; int b = 3; bool c = a <= b; // c is true

>= Greater-than or equal comparison int a = 2; int b = 3; bool c = a >= b; // c is false

! Logical NOT bool c = true; c = !c; // c is false

&& Logical AND bool a = true; bool b = false; bool c = a && b; // c is false

|| Logical OR bool a = true; bool b = false; bool c = a || b; // c is true

% Remainder int a = 5 % 3; // a is 2

++ Increment int a = 3; a++; // a is 4

-- Decrement int a = 3; a--; // a is 2

+= Compound addition int a = 3; a+4; // a is 7

For further details, see “Structure” section in https://www.arduino.cc/reference/en/



Code Basics - Functions
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● void setup() and void loop() are our basic 
functions in Arduino.

● void indicates that these functions do not 
output any values.

● The empty brackets () indicates these 
functions do not take any inputs.

● We can define new functions to help 
modularise our code.

● The output of a function can be set to any 
of the variable types.

● E.g. 
○ int timesTwo(int x){

■ return x * 2;
○ }

● We can have multiple inputs as well.
GROWBOTICS code: Basics > functions



Code Basics - Variable Scope
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● Variables declared outside of 
functions are in global scope.

○ Can be used by any 
function.

● Variables declared inside a 
function are in local scope.

○ Can only be used by the 
function they are in.

GROWBOTICS code: Basics > variable_scope



1. Remember, the Arduino is a separate computing 
device, independent of your PC.

2. We can use a Serial connection through the USB 
connection to communicate with the Arduino.

3. You can then send and receive strings and characters 
between your PC and the Arduino.

4. Useful for debugging your code if things are not 
working the way you expect, but there are no 
apparent errors.

5. Use the Serial Monitor to send/receive values 
to/from the Arduino.

6. The 9600 in Serial.begin(9600) is the baud rate. This is 
the rate at which symbols are sent over the Serial 
channel.

○ There are fixed speeds the baud can be set to, 
9600 is the default.

○ The Arduino baud must match the PC baud.
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Communicating with Arduino

More information on Serial functions can be found here:
Serial page - 
https://www.arduino.cc/reference/en/language/functions/communication/serial/

GROWBOTICS code: Basics > Serial

(5)



Ex 1. Warmups!
1a) In a new sketch, send the message “Hello World!” from your Arduino to the PC.

1b) Modify this sketch to receive a name from the PC and respond with “Hello 
<name>!”.

2a) In a new sketch, write a function which calculates the circumference of a circle. 
Use the terminal to inspect your function output.

2b) Modify this sketch to give 5 decimal points.

2c) Modify this sketch to take an input radius from the terminal and output the resulting 
circumference.
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● If/Else
○ Controls whether sections of code 

execute based on a conditional check.
● For

○ Executes a section of code for a defined 
number of steps.

○ Keeps track of step count with an 
incrementing counter.

● While
○ Executes a section of code until an input 

conditional check has been satisfied.
○ Use cautiously on Arduinos. Remember, 

void loop(){...} handles the iterations of 
your main code.

For each control structure, the affected code is 
enclosed in curly brackets {...}

Code Basics - Control Structures

20GROWBOTICS code: Basics > control_structures



● You can have arrays of different variables.
● Defined in same way as previous variables, 

but with [] after the variable name.
● You can predefine the array size (for 

efficiency), e.g. char arr[10]
or leave it blank (indicating it varies in size).

● You access array elements using square 
brackets and an index that begins at zero.

○ char myName[] = “Aran”;
○ myName[3] = ?

Code Basics - Arrays

21GROWBOTICS code: strings_1darrays



● You can have arrays with more than one 
dimension.

● Similar to the 1D case, you access array 
elements using square brackets, but 
provide two indices indicating the 
[row, column] address of the array entry.

Code Basics - 2D Arrays

22GROWBOTICS code: 2darrays



Ex 2. Control Structures & Arrays
1a) In a new sketch, define a char array with your name and upload it to your Arduino. Note how much storage space the 
program takes. Change the name variable to type String and reupload the sketch. Note how much storage space the 
program now takes. Which takes more? Why?

1b) Modify the sketch to print your name to the terminal backwards on one line.

1c) Modify this sketch to only print the vowels in the provided name.

Part 2 is a longer exercise, see how far you can get before lunch (and maybe try finish it at home!)

2a) In a new sketch, write code which will print an 3x3 naughts & crosses grid to the terminal using ‘x’ for player 1, ‘o’ for 
player 2 and ‘ ’ for empty positions.

2b) Modify this sketch to receive a command input of [player, row, column], e.g. for player 1 placing an x in the top left 
position we would send “100”, the sketch should then output the updated grid. Ensure the provided move is allowed.

2c) Modify this sketch to check if a player has won, or if there has been a draw.

23



Lunch & Tour!
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Four people need to cross a rickety footbridge; they all begin on the same side. It is dark, and they 
have one flashlight. 

A maximum of two people can cross the bridge at one time. Any party that crosses, either one or two 
people, must have the flashlight with them. 

The flashlight must be walked back and forth; it cannot be thrown.

Person 1 takes 1 minute to cross the bridge. Person 2 takes 2 minutes, person 3 takes 5 minutes, and 
person 4 takes 10 minutes. A pair of people must walk at the slower persons rate.

What is the shortest time for all four people to cross the bridge?

From “Algorithmic Puzzles” - A. Levitin & M. Levitin



Schedule
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10:30 - Arrive & register
11:00 - Introductions
11:30 - Arduino 1: Intro
13:00 - Lunch
14:00 - Tour
14:30 - Arduino 2: Sense + Act
15:30 - Processing 1: Visualise
16:30 - End of Day

Day 1
10:30 - Arrive
11:00 - Industry Talk + Q&A
11:30 - Arduino 3: Motion
13:00 - Lunch
14:00 - Arduino 4: AI
15:00 - Challenge Competition
16:30 - End of Day

Day 2



Arduino 2: Sense & Act

● Arduino Input/Output (I/O)
● Reading Sensors
● Basic Components
● Autodesk Circuit
● Controlling Actuators
● Bringing it all together!

26



Arduino I/O
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1. Digital I/O
a. On/Off Signals (0/5V @ 20mA)
b. Digital Communications

2. Analog Input
a. Reading Sensors (0-5V)
b. Can act as digital pins
c. 10-bit accuracy
d. ~9.6kHz maximum sample rate 

(affected by your code)
3. PWM Output

a. Analog Output, (0V-5V @ 20mA)
b. Controlling speed of motors,

brightness of LEDs, etc.
Maximum current output for 
all output pins is 200mA 

- Think Ohm’s Law, V = I . R
4. Power Pins

a. 3.3V & 5V supplies
b. Vin - input voltage for powering with batteries/power sources (7V-12V)

(1) & (3)

(2)(4)



Accessing I/O in Code
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1. Digital I/O
a. Set pinMode in setup()
b. digitalWrite(pin, val);
c. Here val is 0 or 1
d. Can also set to false or true
e. digitalRead(pin,val);

2. Analog Input
a. Set pinMode in setup()
b. analogRead(pin);

3. PWM Output
a. Set pinMode in setup()
b. analogWrite(pin, val);
c. Here val = 0-255;



● Build circuit and write code to digitally control one of the LEDs.
● Read in the photoresistor signal, and use this to control the brightness of the other LED.

29

LED 
Resistors 
220 Ohm

LDR 
Resistor 
10kOhm

Ex 3.



● Notice we do not use the 
photoresistor on its own.

● The photoresistor’s resistance 
varies with light levels.

● However, analog pins measure 
voltage, not resistance.

● The extra resistor forms a voltage 
divider circuit. Changes in 
resistance will result in varying 
voltage.
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● R1 represents the photoresistor.
● R2 represents the added resistor.
● Vin is 5V
● If we want a 0-5V range, what is 

roughly the best value for R2?
● Measure R1 in light
● Measure R1 in dark

Ex 4

Calibrate your 
photoresistor 
as best you can 
for dark, 
medium, and 
bright light.



● Create an account on Tinkercad https://www.tinkercad.com/
● Remake the circuit from Ex 3. and repeat your results.

31

Ex 5.



Controlling Higher Power Actuators
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1. Transistors
a. Main purpose is a signal amplifier, 

but can be effectively used as a switch..
b. Two varieties, NPN (5V On, Ground Side) and PNP (0V On, High Side).
c. Can use PWM signal. Very cheap.
d. Requires Base Resistor between control pin and gate (B), similar to LEDs

2. Relays
a. Some relay coils require too much current for an Arduino digital pin to energise. 

You can either make sure to get a relay that is compatible with Arduino I/O (5V @ 
20mA), or use a transistor to amplify your control signal.

b. Can control AC voltage (this can be very dangerous though).
c. Reasonably cheap.

3. H-Bridge Motor Driver
a. Motor drivers can allow you to control high power devices.
b. H-Bridges use a switch-based circuit to give you control of direction a motor turns.
c. Depending on specific chip used, can also allow for speed control - Can use PWM 

signal.
d. Gets more expensive when using motor drivers.
e. We will explore the use of these tomorrow!

NPN

PNP



Ex 6. The GROWBOT

● Measure the soil moisture.
● Measure the temperature.
● Measure the light-levels.
● Activate the water pump if the soil is dry.

○ Must use your relay due to pump current requirements.
○ Research online for how to build this circuit.

● Challenge 1: Save this data to the Arduino’s built-in memory.
● Challenge 2: Using this historical data, determine some algorithm to measure plant 

health.
● Template sketch available in GROWBOTICS code > InputOutput > GROWBOT

What could be added to the system to help track the plant health, or control it’s environment 
further?

33



Processing: Visualise

● Processing Environment
● Sending data from Arduino to Processing
● Plotting your data
● Saving your data

34



● Similar environment to Arduino IDE.
● Uses Java instead of C/C++, but syntax 

generally similar.
● Similar to Arduino, we have a setup function 

which runs once.
● Instead of a loop function, we have a draw() 

function.
○ Processing is designed to make it easy 

to create visual applications.

● Let’s just look briefly at this.

Processing

35



Using your Arduino sketch for reading the photoresistor, 
output the analog data using println - 
Serial.println(analogValue)

In Processing...
1. Define the size of the window you would like to 

create (in pixels).
2. Establish a connection to the serial port that the 

Arduino is talking to.
a. If a connection can’t be made when you run 

the code, but you can see the Arduino output 
values in the serial monitor, try changing the 
device index “dev_ind” (try 1, 2, 3).

3. Check if data is available, and if so read it in.
4. Parse the data from a string format to integers.
5. Filter the data to make it easier to view.
6. Plot the data
7. See example “processing_minimal_arduino”

a. Pairs with Arduino code analog_send

Processing - Plotting an Analog Value

36GROWBOTICS code: InputOutput > processing_minimal_arduino



Ex 7. The GROWBOT GUI

● Plot the soil moisture.
● Plot the temperature.
● Plot the light-levels.
● Plot when the water pump is activated.
● Challenge 1: Save this data to a file. See 

Examples > Topics > FileIO > SaveFile1
● Challenge 2: Create a button to turn the 

pump on manually. See Examples > Topics 
> GUI > Button (in processing)

Example in GROWBOTICS code > InputOutput > 
GROWBOT_gui
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Day 2
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